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3.1  INTRODUCTION 

Satellites have been used to transmit telephone calls and television signals 

since the 1960s. Even though undersea cables were used to transmit voice channels a 

long time before then, those was not suitable to transmit TV signals since the systems 

were bandwidth limited. At this time and with the fast development of the 

digital system and telecommunication technologies, the GEO and other satellites 

communication system are able not only to deliver TV-broadcasting programs but they 

also can deliver for example: Internet services, Voice and data services and Broadband 

VSAT. 

In the beginning the broadcasting programs were used analogue which 

requires high transmission power, especially at the repeater system existing in the 

satellite segment part. But with the birth of the digital era, all the 

transmissions/receptions system were transformed into digital devices leading to 

increased channel capacity per each transponder carrier and less downlink power 

to be used on the satellite. All the TV-broadcasting satellite systems, which are a 

part of the so-called "Direct Video Broadcasting by Satellite”, have GEO-stationary 

orbits. DVB-S is a broadcasting standard system for television, video and radio 

services and has the main characteristic to transmit these kinds of signals with a 

high power level and therefore allows the user segment to use small dish antennas to 

be connected to their receivers[93]. 

To make possible a good home reception, microwave engineers, who are 

responsible for designing the whole transmitting and receiving link system, had to 

make good link budget calculations that not only take into account the satellite 

transmitted signal attenuation factors due to the free space propagation and the 

corresponding receiving system noise and the noise collected by the antenna and also 

from the attenuation factors when the signal pass the atmosphere. That is why an 

extra link margin is added to the minimum C/N ratio needed by the ground receiving 

system to achieve a good TV-picture and sound quality. 

 

In this chapter, information and technical details of the methodology used for 

the “Propagation studies and their impairments at Ku and Ka band frequencies” tested 

with commercially available Direct to Home (DTH) Receiver, KLUniversity (16.44
o
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N, 80.62
o
 E). The main aim of this chapter is to analyze the direct broadcasting 

Television signals coming from GEO-stationary satellites which are usually in C-Band 

& Ku band frequencies. The major focus of the chapter is Ku band frequencies because 

they are more prone to atmospheric parameters leading to lot of losses in view of 

signal degradation. The received signals were analyzed in terms of signals strength, 

signal-to-noise ratio (SNR), signal interference, cross polarization and atmospheric 

attenuation factors. For this purpose, a small receiving station working at Ku-band 

frequencies is constructed using a domestic TV satellite antenna and receiver. Once 

the receiving station is operational, systematic investigations on the above-mentioned 

topics are done and documented to check the system performance.  

 

3.2  EXPERIMENTAL SETUP AND TECHNICAL DETAILS 

  3.2.1 DESCRIPTION 

The satellite receiving antenna available at seventh floor of C block 

KLUniversity, which is approximately 362 m above sea level on the point of latitude 

16.44
o
 N and longitude 80.62

o
 E, and is directed toward INSAT4A on the 

geostationary orbit of longitude 83.0
0
 E used for the studies.   An efficient technique 

of aligning Dish Antenna for DTH satellite reception has been experimented during 

the setup shown in Figure 3.1,with the help of IFR Americas 2398 (30 KHz-1.5 GHz) 

made Spectrum Analyser. The Procedure is based on received IF satellite spectrum in 

the range of 950-2050 MHz observed using spectrum analyzer.  

 

Figure3.1-Dish Alignment for a particular location to receive the satellite signals from 

GEO stationary orbit for INSAT 4A/GSAT 10 satellites. 
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Receiving station was constructed by using an offset parabolic dish antenna 

with size 90cm diameter, a low noise block down converter (LNBF)  connected to the 

antenna, down converted signal  applied to  the spectrum analyzer, lap top or pc used 

to stored the received data in the system memory all this data transformation is 

through coaxial cable in support with GPIB cable, which are shown in Figure 3.2 . 

The interface between IFR2398 (9 KHz-3GHz) spectrum analyzer and 

PC/Laptop had been established with National Instruments GPIB. A Virtual 

Instrument (VI) was developed with the available options of Lab VIEW 11.0 

Professional Edition, Lab VIEW Real Time Module 11.0, [99], LabVIEW Signal 

Express 2.5 [100] along with add-on modules from National Instruments for reading 

the data from the spectrum analyzer during proposed run time application with a 

sampling time of 10s and the data can be stored directly to excel spread sheet with 

(*.txt or *.dat) format in the hard disk. 

 

Figure 3.2 – main components of the receiving station are shown in the diagram.  

 

using the above system  Ku –band satellite beacon  parameter like strength of 

the signal  with regular time basis  during clear air and also during rainy  conditions 

and further it was  analyzed.  
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As a part of this work, beacon frequency is continuously recorded for 10 

seconds interval on 24 hour basis for two years August 2012 to September 2014 using 

90cm dish antenna. Rain rate data is collected using OTT persivel disdrometre with 

10 second integration at the same place where beacon signal is monitored. Both the 

signal strength and the rain rate are simultaneously recorded for every 10 seconds and 

the data collected for further analysis. Efforts were made to record signal strength 

fading during heavy rainy days [94]. 

 

3.2.2  THE LOW NOISE BLOCK DOWN CONVERTER "LNBF" 

 LNBF Low noise Block-down converter and it is a microwave device that 

amplifies the weak received satellite signals and down converts them to lower 

frequency signals before they reach the TV/video receiver. It is the typical device 

used by domestic satellite TV reception antennas, which is mounted in the focal point 

of prime focus or offset antenna dish systems [95]. In this section only the Ku-band 

LNB is discussed since it is the device that was used to study the frequency bands of 

interest for experimental setup in this thesis.  

 

a weak satellite signal which is in the order of micro watts is collected by 

using parabolic dish antenna. satellite down link signal focused by the surface of the 

dish to the dish focal point. These weak signals are processed by the high sensitivity 

electronic equipment. Received micro level signal was amplified by low noise 

amplifier to the required level and then the high frequency signal which is in the Ku 

band frequency range is down converted by down converter using two local oscillator 

frequencies 950GHz and 1075GHz  depending on the polarization. In this work dish 

antenna was aligned to receive the vertically polarized signal. 

 

A block diagram of  LNBF consists of 4 main sections which are shown in 

Figure 3.3 viz: local oscillator, mixer, IF amplifier and filter.  
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.  

Figure 3.3 - Detailed block diagram of LNBF. 

 

Mixer: mixers are used to convert frequency rage of the informative signal with out 

disturbing the information. Heterodyning principle was used to convert Ku band 

frequency signal to IF frequency range. Mixer will produce multiple no of out put 

frequencies with the combination of fixed incoming frequency along with received 

signal. One of the out put of the mixer is difference frequency or down converted 

frequency remaining all frequencies are eliminated by the filter. 

 

Local Oscillator(LO): mixer down converts the incoming signal frequency using 

fixed frequency  input that is supplied by the local oscillator.LO is the internal pert of 

the LNBF  that’s why it will called as Local oscillator.the list of local oscillator 

frequencies are shown in table 3.1 are standardized by LNBF manufacturers for all 

satellite down link frequencies. The local oscillator frequency are typical but not an 

international standard[96].  

 

Table 3.1 - Local oscillator frequencies. 

Reception Frequency 

(GHz) 

Local Oscillator Frequency 

(GHz) 

Output Frequency  

(MHz) 

2.5 – 2.7 3.65 950 – 1150 

3.4 - 4.2 5.15 950 - 1750 

4.5 – 4.8 5,95 950 – 1250 

10.7 – 11.8 9,75 950 – 2050 

10.95 – 11.70 10.0 950 – 1700 



Experimental Hardware                                                                                 Chapter3 
 

54 
 

11.70 – 12.5 10.6/10.75 950 – 1750 

12.25 – 12.75 10.6/10.75 950 - 1450 

12.25 – 12.75 11 950 - 1450 

12.5 – 12.75 11.475 1025 - 1275 

 

 A feed horn connected to a waveguide is placed in front of the LNB to ensure 

that most of the radiation and is coupled antenna probe sitting at the end part of the 

waveguide. There are two such probes inside the waveguide that are connected 

perpendicular to each other, one for receiving the horizontally polarized signals while 

the other probe works with the vertical signals instead. Here the EM radiation is 

transformed into electrical signals that are further connected into the LNB low noise 

amplifier, which amplifies the received signal and suppresses the unwanted noise 

level as much as possible. Then it is mixed with a 9.75 or 10.6 GHz sinusoidal signal 

(each one generated by two independent local oscillators) to down convert the input 

signals. Finally it is amplified one more time before sending them trough the coaxial 

cable that is connected to the TV/video receiver at the end part of the cable line. 

A band pass filter is connected before the second amplification stage to filter 

the unwanted harmonics frequencies and noise generated in the down conversion 

process. The LNB is able to switch between horizontal and vertical polarization 

signals by using a 13 Volts (for vertical polarization) or a 17 Volts (for horizontal 

polarization) reference signal coming from the receiver. The same receiver "tells" the 

LNB if the choice of the band is the higher (10.7-11.7 GHz) or the lower band (11.7-

12.75 GHz). The down conversion process is needed since otherwise the signal would 

not go further than 1 meter trough the coaxial cable due to damping. Two local 

oscillators are used by the LNB because the total bandwidth of approximately 2.05 

GHz is too large to go through the same coaxial cable and that is why it must be split 

into the high a low band as it is shown in the Figure 3.3.   

A TV system which depends on Ku band satellite signal these systems use a 

Low noise amplifier connected at focal point of the dish antenna. Amplified signal 

connected to the indoor receiver through a coaxial cable which has 50 Ohm 

impedance. In some systems received signal directly connected to the down converter 
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which converts the incoming signal frequency to intermediate frequency. LNBF 

which is having mixers, local oscillator and filter.    

 

3.2.3  SET TOP BOX (DISH TV OR TATA SKY) 

          Set top box is an intermediate device which provides an intermediate platform 

between user and internet and it provides the environment to the system to decode the 

digital television signal. These set top box is act like a receiver, and is necessary for 

the analog systems who wants to receive the digital channels.a typical set top box was 

shown in figure 3.4  

 

Figure 3.4 - Set Top Box schematic view. 

Block Diagram of Set-Top Box: STB’s are program based devices they are 

controlled by micro controllers. These boxes are used to control the television 

channels. Set-top boxes are used to control the conversion of the media signal 

transmitted from a content provider into the images and sounds that are provided by a 

corresponding media display device. The block diagram of typical setup box is shown 

in Figure 3.5. 
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Figure 3.5 - Block diagram of typical set top box. 

 

A STB connected to a television set and activates various media services like 

cable television broadcasts, Reception of satellite signals,internet connections via a 

telephone line[97]. Figure 3.6 shows the overall DTH technology schematic block 

diagram consisting of all the components mentioned above.  

 

Figure 3.6 - DTH Technology Schematic Block Diagram 
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3.2.4 RECORDED OBSERVATIONS IN SPECTRUM ANLYSER  

The bouquet spectrum of DTH is given in Figure 4.7 using Ku band, where 

11510, 11550, 11630 and 11670 MHz are the bouquet-frequency bands. Each bouquet 

here consists of twelve channels.  

 

 

 

Figure 3.7 - The total DTH spectrum in Ku band. 

 

The procedure is based on received IF satellite spectrum in the range of 950-

2050 MHz which is generally available at the output of ODU (Outdoor Unit of DTH) 

on a FSP spectrum analyzer typical observation snapshot is shown in Figure 3.8.  

The stored satellite spectra and other important data that later on were 

processed with the help of the MATLAB software. Several MATLAB codes were 

developed with Graphical User Interface to help with the analysis of the different 

satellite spectrums, the calculation of link budgets and running ITU-R (International 

Telecommunication Union Radio communication section) models for rain attenuation, 

cross polarization and atmospheric scintillation predictions. 

 

  

Figure 3.8 – Ku-band spectrums of DTH received signal as observed in Spectrum   

Analyzer (IFR Americas and Rohde Schwartz) . 
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The receiving antenna system seems to be suitable to make short time 

measurements where the determination of signal strengths, noise levels, carrier to 

noise ratio and cross polarization parameters on different digital transponders shall be 

investigated. It also proved o be useful to analyze direct data from the measured 

spectra such as transponder bandwidths and to determinate the amount of noise 

contributions due to interference. Tropospheric scintillation effects were also able to 

be observed with the help of the receiving system. From long time statistic 

measurements that could be useful for the investigation of scintillation effects (due to 

variation of tropospheric refractive index or due to more severe weather conditions 

such as the presence of clouds or rain) at different frequencies and elevation angles.  

 

3.3  DATA ACQUISITION SYSTEM 

Data acquisition means acquiring the real data from the instrument and 

processes that data using computer, and store the processed data in any required 

format for further data processing. Figure 3.9 shows the components of a typical  

DAQ system. Physical phenomena of the real-world signals can be measured, and by 

using transducers to estimate the physical phenomena and  also produce the electrical 

signals proportionately. 

 

Figure 3.9 - DAQ System. 

 

 Using Lab VIEW module control the DAQ devices for  analog input signals 

(A/D conversion),  and generate analog output signals by using D/A conversion, and 

processed intermediate data was the digital data. In the case beacon data  input signal 

is the analog signal, the voltage data from the sensor goes into the plug-in DAQ 
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devices in the computer, which sends the data into computer memory for storage, 

processing, or other manipulation. 

Signal conditioning modules are controlled by electrical signals generated by 

transducers so that they are in a form that the DAQ devices can accept. Signal 

conditioning modules can generate to many different types of commands for 

conditioning : amplification of the signal , linearization, filtering of unwanted 

frequencies, isolation, and so on.  The typical DAQ devices shown in Figure 3.10.   

 

Figure 3.10 - Types of DAQ devices are available from NI. 

 

Data Acquisition is possible by using the setup developed with NI virtual 

instrumentation. For developing VI module the computer must be configured with NI 

Lab VIEW, it needs DAQ system, and appropriate device drivers to support data 

communication between these devices.  

 

For the proposed setup, to measure the signal strength (dBm) with reference to 

time, it is needed to be given for an analog input channel on the DAQ device in the 

computer.  .  Then using LabVIEW’s DAQ VI (Extension for Lab view Files *.VI) to 

read the channel on the board, display the peak of the Signal Strength on the screen 

using the external Peak & Hold Circuit [98] from NI Multisim 10.0 Simulation 

software or by programming button available in most of the spectrum analyzers, 

record it in a data file, and analyzed in post processing sessions as per the 

requirement. 

 



Experimental Hardware                                                                                 Chapter3 
 

60 
 

3.3.1 GPIB 

to support high speed data transformation between computers and instruments, 

in 1960 Hewlett  Packard developed the more General Purpose Interface Bus or 

GPIB, it provides a set of protocols to control the instrument. In 9175 the Institute of 

Electrical and Electronics Engineers(IEEE) standardized the GPIB, and is known to 

us as IEEE 488. earlier it supports the communication between computer to computer 

and later it was extended to computer to  other instruments like meters, oscilloscopes 

and  spectrum analyzers also. GPIB supports parallel bus communication between the 

devices in the form of ASCII code. One end must be connected to the computer 

because computer can decode the ASCII code by using GPIB board, or proper drivers 

must be installed in computer. such as those instruments are shown in fig 3.11  

 

 

Figure 3.11 - GPIB boards from NI. 

To send data and appropriate commands to listeners from tracker data transfer bus 

was used and all the listeners must use  unique system address. Virtual Instrument 

developed with NI Lab VIEW will manage the address and data communication 

between devices and listeners. The following Figure 3.12 shows a typical GPIB 

system. 
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Figure 3.12 - Typical GPIB system containing one  GPIB controller board and  more 

GPIB enabled instruments  

 

Although using GPIB is one way to bring data into a computer, it is 

fundamentally different from performing data acquisition, even though both use 

boards that plug into the computer. Using a special protocol, GPIB talks to another 

computer or instrument to bring in data acquired by that device, while data acquisition 

involves connecting a signal directly up to a computer's DAQ device. To use GPIB as 

part of  virtual instrumentation system, it is needed a GPIB board or external box, a 

GPIB cable, LabVIEW and a computer, and an IEEE 488-compatible instrument with 

which to communicate (or another computer containing a GPIB board). For this, 

GPIB driver software to be installed in the computer, according to the directions that 

accompany LabVIEW or the board. 

3.3.2 Communication Using The Serial Port 

 

Serial communication is another popular means of transmitting data between a 

computer and a peripheral device such as a programmable instrument (or even another 

computer). LabVIEW can perform serial communication (RS-232, RS-422, or RS-485 

standards) using built-in or externally attached (for example, USB serial adaptors) 

serial ports on the computer. Serial communication uses a transmitter to send data one 

bit at a time over a single communication line to a receiver. Built-in serial ports on a 

computer are almost always RS-232 typical case shown in Figure3.13 As RS-232 is 

one of the most common types of serial communication, sometimes RS-232 ports are 

simply referred to as "serial ports". 
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Figure 3.13 - Typical (RS-232) serial system containing one RS-232 enabled 

instrument connected to a computer via its serial port. 

 

Serial communication is handy because most PCs have one or two RS-232 

serial ports built in, one can send and receive data without buying any special 

hardware. Some newer computers do not have a built-in serial port, but it is easy to 

buy a USB to RS-232 serial adaptor for about the cost of a USB mouse. Although 

most computers also now have USB (universal serial bus) ports built-in, USB is a 

more complex protocol that is oriented at computer peripherals, rather than 

communication with scientific instruments. Serial communication (RS-232, RS-422, 

or RS-485) is old compared to USB, but is still widely used for many industrial 

devices.  Many GPIB instruments also have built-in serial ports. However, unlike 

GPIB, an RS-232 serial port can communicate with only one device, which can be 

limiting for some applications. Serial port communication is very slow and has no 

built-in error-checking capabilities. However, serial communication has its uses (it is 

certainly economical), and the LabVIEW Serial library contains ready-to-use 

functions for serial port operations. RS-422 and RS-485 are commonly called "multi-

drop serial" and can facilitate communication between multiple devices on a single 

bus. RS-422 and RS-485 are also less susceptible to noise and allow longer cable 

lengths, which are reasons that they are commonly preferred (over RS-232) for 

industrial applications. 

 

In this thesis serial port communication method is used in the experimental 

setup described above and is a low cost Ku band experimental setup for propagation 

impairments studies using earth-space satellite communication links. 
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3.3.3 VISA Functions 

As mentioned earlier, VISA is a standard I/O Application Programming 

Interface (API) for instrumentation programming. Almost all instrument drivers for 

LabVIEW use VISA functions in their block diagrams. VISA can control VXI, GPIB, 

PXI, or serial instruments, making the appropriate driver calls depending on the type 

of instrument being used. 

 

3.3.4  Connecting The PC To The Real World Applications 

Once getting data into the computer, processing can be done by different ways 

on the data. It was realized after doing the setup with RS232c standard the advantages 

are more when a DAQ device is plugged into the computer even though costlier 

aspect high data rates can be expected. Figure 3.14 shows the view of general 

acquisition device connected to the computer. 

 

 

Figure 3.14 - Illustration of the computer connected to the real world devicesusing 

data acquisition hardware.  

3.3.5 Instrumental Control in LabVIEW  

Use the National Instruments Instrument I/O Assistant to communicate with 

message-based instruments and graphically analyze the response. For example, it can 

be used to communicate with an instrument that uses a serial, Ethernet, or GPIB 

interface. The Instrument I/O Assistant organizes instrument communication into 

ordered steps . Four steps are available in the Instrument I/O Assistant. A model 

assistant palette in LabVIEW which is shown in Figure 3.15. 



Experimental Hardware                                                                                 Chapter3 
 

64 
 

Select Instrument— by using this step to select the instrument you want to 

communicate with and to configure basic instrument properties. This step appears in 

the step sequence window when you launch the Instrument I/O Assistant and must 

always be the first step in any Instrument I/O Assistant sequence.  

Query and Parse— with this step to send a command to the instrument, read a 

response from the instrument, and parse the returned data.  

Write— this step can be used to send a command to the instrument.  

Read and Parse—this steps to read a response from the instrument and parse the 

returned data. Building a sequence of steps, you then execute the sequence to 

communicate with the instrument. When execution completes, use the response 

window in the Read and Parse view and Query and Parse view to interactively 

parse data into tokens and assign new data types to the tokens you create.  

 

 

Figure 3.15 - I/O Assistant Palette in LabVIEW 

 

3.3.6 Understanding Analog and Digital I/O  

The measurement I/O>>DAQmxData Acquisition palette in Figure 3.16 

contains all of the VIs, and other tools that you will need to explore DAQ, or Data 

Acquisition one of LabVIEW's great strengths. In fact, LabVIEW's DAQ capabilities 

might even be the reason chosen to establish the set-up which could quickly acquire 

data and generate signals to measure, control, turn on and off, or blow up stuff in the 

external world.  
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Figure 3.16 - DAQmxData Acquisition palette. 

 

3.4     PROCEDURE TO USE DAQ ASSIST IN LAB VIEW SIGNAL EXPRESS 

MODULE  

The following section explains, procedure to record and file data with the help of 

integrated data logging features in Lab VIEW Signal Express, with precise steps to 

record  particular signal, play back and examine the signal using analysis steps. By 

using recording options, log signals can be viewed depending upon specified initial or 

final conditions. Lab VIEW Signal Express enhances the virtual instrumentation for 

design engineers by providing immediate interactive measurements which need no 

programming. Lab VIEW Signal Express can be used interactively to acquire, 

generate, examine, correlate, import log signals. Lab VIEW Signal Express broadens 

the utilization and performance of virtual instrumentation to those who need to 

acquire or examine signals without programming [99][100]. 

      The steps to be followed to open a New project in Lab VIEW Signal Express: 

1.Open  LabVIEW Signal Express, which then  splits  into three primary views: which 

are Project View, the Data View, and help on left, middle and right of the screen 

respectively. In the Data View, three tabs namely, Data View, Logging Options, 

Project Documentation tab can be seen[99][100]. 
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2.To outset a New Project, on the top left select File » New Project, save as Lab 

VIEW Signal Express project[99][100]. 

3.Analyze the window that come into sight, as shown in Figure 3.17 to acquire 

information about different components of Lab VIEW Signal Express using the help 

window hidden [99][100].  

 

3.4.1 Simulating The Project and Unveiling Signals: 

Two types of execution modes are available in Lab VIEW Signal Express ---Run and 

Run Once. While Run button is clicked, the Lab VIEW Signal Express runs all stages 

in the project successively till the Stop button is clicked which comes into sight 

instead of the Run button as the project runs. Data View updates continuously as the 

steps in the project are executed. One can modify the measurement contours and view 

the results instantly even when project in running mode. For modifying the contours 

of steps while a project executes, Lab VIEW Signal Express provides you direct, 

immediate feedback on the modifications made. Lab VIEW Signal Express executes 

all stages in project one time, when Run Once button is clicked [99][100]. 

 

The steps to be followed to record a signal in a file  

1. Click Add Step icon choose select Load/Save Signals » Analog Signals » Save to 

ASCII/LVM. 

 

Figure 3.17 -Lab VIEW Signal Express general window 
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2. Select the Signals tab in Step Setup dialog box and choose filtered step from the 

Input Data drop-down box. 

3. In File Settings tab, save the file in appropriate location in the Export file path 

control. 

4. Choose Overwrite, if the file already presents in drop-down menu. 

5. Choose Generic ASCII from the Export file drop-down menu. 

6. Close button is to be clicked to close the Step Setup dialog box. 

7. Chose the Run icon to simulate the project and save the output signal to a 

specified ASCII file. 

8. Choose Save from File to save the project. 

9. Choose Close from File to close the project. 

 

3.4.2 Recording and Dumping Signals to Microsoft Excel 

To export signal data to Microsoft Excel, open Excel and drag the output signal of a 

step in Lab VIEW Signal Express to an Excel spreadsheet. 

The steps to be followed to specify and to archive the signal: 

 

1. Choose File, click on Open Project and select navigate. 

2. Choose the Record icon, indicated at left, to access the Logging Signals 

Selection dialog box which displays the output signals available in the project 

for recording. It is must to mention a name and explanation for the log. 

3. Check in the signal checkbox to save the signal produced in the Create 

Signal stage. Choose the OK icon to terminate the Logging Signals Selection 

dialog check box and initiate recording the created signal. Until Stop button is 

clicked, the logging operation continues. 

4. To stop logging the signal, click the Stop icon, indicated at left. 

5. The logged data is available in the Logged Data window. 

6. By default, LabVIEW Signal Express titles the logged data as per the date and 

time you recorded the data. Logged data is saved in *.tdms file format type in 

the directory mentioned in the Options dialog check box.  

7. Choose Tools and select Options in that choose the Logging option to 

mention the directory for LabVIEW Signal Express to record the logged data 

and to change various options for logged data.   
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8. Select the OK icon to terminate the Options dialog window. Select Save 

Project in File menu to save the project. 

 

3.4.3 Viewing The Logged Signal 

Useful steps for viewing the logged signal: 

1. Select Data View from View toolbar to view the Data View, if the Data View is 

not visible. 

2. The table of whole logged data in the ongoing project is displayed on the Logged 

Data window. Choose the data log that has been recorded from the Logged Data box 

and move the log onto the Data View. The logged data and a preview graph are 

displayed in Data View. The signal appeared in the Data View may vary from the 

signal depending on period of recording the signal. 

3. The preview graph which is displayed by default in the Data view window, while 

examining the logged data, provides a way for zooming and panning through the 

available data. Right-click the Data View and select Visible Items »Preview to 

display the preview graph, while viewing live or non-logged data. 

4. To zoom in on the logged signal, select the Zoom in icon beside the preview 

graph. The markers on the preview graph displays the subset of data currently 

displayed on the preview graph. The data can be scrolled by using the scroll bar 

beneath the preview. To maximize or minimize the subclass of data you are 

visualizing, select and drag the markers on the preview graph. 

5. Select Recording Options in View menu to get the Recording Options View 

window, if the Recording Options dialog box is invisible. 

 

3.4.4 Logging Signals with Prescribed Initial and Final Conditions 

The procedure to be followed for logging signal with predefined start and stop options  

 

1. Select Recording Options from view menu to open the Recording Options 

View window, if the Recording Options dialog box is invisible. 

2. In the Recording Options View dialog box, choose Signal Selection in 

Category list. 

3. Place a tick beside the signal in the Record menu. 

4. The Record icon changes to the Record While Running icon, shown beside 

it. Make sure that the Record While Running icon is active. Lab VIEW 
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Signal Express records the specified signal when you select the Run or Run 

Once icon, when the Record While Running button is active. 

5. In the Recording Options View menu, choose Start Conditions in the 

Category list given. 

6. To customize a start condition for your logging task, select the Add icon in the 

Logging start conditions window.  

a. Select the Signal option in the Condition source control to specify for 

Lab VIEW Signal Express to start recording when the input signal 

satisfies the specified condition. 

b. In the Signal control, select signal. 

c. In the Condition control, select Rising slope to start recording the 

signal depending upon the value at the end of the signal on a positive 

slope.  

d. Insert “l” in the Value control to start recording when the signal 

traverses 1 on a rising slope. 

7. To modify a final condition for your logging task, select the Add icon in the 

Logging stop conditions page.  

a) In the Condition source control, select the Duration option. 

b) Insert “5” in the Duration control dialog box, to record the signal for 5 

seconds after the signal satisfies the initial condition. 

c) Select the Run icon, shown. LabVIEW Signal Express starts recording 

the signal when the signal traverses level ‘1’ on a rising slope and goes 

on recording the signal for 5 seconds. When the signal meets the start 

condition and logging is in progress, the Recording pointer on the 

bottom of the Recording Options View window will turn on. The 

accessible hard disk space on the computer for this log is displayed by 

the Disk information indicator. 

This method of DAQ works perfectly under many circumstances, 

provided: 

1. Select a low sampling rate. (once per 10 seconds). 

2. Other time-consuming operating system (OS) events should not be in 

progress     while the VI is running. 
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3. Sampling times with slight variations are acceptable 

 

3.5  DETAILS OF PROGRAMS (VI’s) DEVELOPED FOR EXPERIMENTAL        

SETUP- DATA LOGGING TASK 

 In the real time observation of rain attenuation studies, ample of programs 

were developed to achieve Data Logging Task. The ultimate target is to transcript the 

signal strength for every 10 seconds of time. Consequently data will be stocked into 

the notepad, excel or LabVIEW compatible file. After stocking the data, it will be 

refined using Scientific Data Analysis Software. The important point to be noted here 

is the programs advanced for the purpose have the capability of examining the data in 

real time i.e., FFT and Power Spectral Density functions present in LabVIEW library 

are used with maximum number of inbuilt functions available in the various toolkits 

which are suitable with latest LabVIEW versions. The upcoming sections give the 

information of the programs that were advanced ,starting with different capabilities of 

governing the instruments affiliated to the PC equipped with LabVIEW Software with 

Toolkits, to the final task of preserving the real time data to the notepad file, used for 

post refinining,  it also consists of front panel and block diagram of the programs, 

with order of LabVIEW library functions exercise. Jeffery and Jim Kring [142]; Rick 

et al.,[143] comprise the programming approaches which are used as references for 

growing the data logging module.  The Schematic diagram of the blocks developed 

for experimental setup displayed in Figure 3.18.  
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Figure 3.18 - Schematic view of the programs developed for experimental setup.  

3.5.1 Instrument Connectivity - Serial Port by Write and Read 

             The behavior of a primary serial read and serial write program are a 

serial port read or write, or amalgamation both of these duties. The operator 

chooses one of these activities (read option or write option) in the front 

window.  If both of them  are chosen, the VI would  initially write and read the 

data, and then afterwards it closes the VISA phase that  was opened to the 

port.  The VI have to pause until the necessary number of bytes are 

accumulated near  the port. The number of bytes required will only  be read. 

The steps involved are: 

1. Choose the serial resource and configuration constraints (baud rate, 

data bits, parity, stop bits, flow control). 

2. Select the processes to be implemented.   

3. Link up the serial port to your piece of equipment.  If  device is not 

available, carry out a loopback test by doing one of the following.  

Short  the pins 2 and 3 on a RS-232 cable or short the pin 4 to pin 8 

and also the  pin 5 to pin 9 on a RS-485/422 cable.  

4. Run the VI to see whether the is data read.  (The "read string" will 

balance the "string to write" if a loopback test was executed.) 
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  The constraints which are fixed for the serial port must balance the constraints of the  

instrument or device fixed. In this  particular program, the bytes to read the parameter 

mentions the required number of bytes that the serial port reads. If there are more 

number of  bytes at the port than the number required  in bytes to read, those bytes 

will not be read. The controls used to configure the basic constraints such as baud 

rate, data bits, and parity were shown in the front panel . After the VISA aligns the 

serial port, VI opens the VISA session, the VI sends the VISA resource name to 

alternative VIs that executes operation on that VISA resource. The VISA write 

function passes a command to the serial instrument and the VISA read function gives 

back the data depending on the instruction passed by VISA write function. The VISA 

close function then closes the reference to the serial  piece of equipment. It is essential 

to exit the reference; otherwise message through with that port through protocols 

other than VISA might be impossible. Device connectivity control and front panel is 

displayed  in Figure 3.19 and its block diagram in Figure 3.20 
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Figure 3.19 - Window used for Instrument connectivity check with RS232C Cable 

(Serial Port) by Reading and Writing data to/from instrument  

 

 

Figure3.20 - Block diagram of basic serial read and write connecter pane and panel 

windows. 

 

3.5.2 Using VISA- 2 Port Serial Write and Read 

The Serial Write and Read (2Port) program opens  two VISA windows and arranges 

one COM port to execute a write operation and the other COM port to execute a read 

operation correspondingly.  This VI will pause until the stated no of bytes (bytes to 

read) is obtained at the port.  Only the no of bytes in demand will be read. The control 
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and front panel of VISA- 2 Port serial write and read dialog box is displayed in Figure 

3.21 and block diagram in Figure 3.22. 

 

The steps included in here are: 

1. Choose the serial resource and configuration constraints (baud rate, data bits, 

parity, stop bits, flow control). 

2. Select the functions to be excecuted.   

3. Fix a null modem RS-232 or RS-485/422 cable in the middle of  2 ports. 

4. Execute the VI to view the "read string" balance with the "string to write". 

 

 

 

Figure 3.21- Connecter pane and control panel of VISA- 2 Port serial write and  

            read window 

 

Corresponding to the Basic Serial Write and Basic Serial Read VI, this VI permits 

you carry out investigative try-outs on your ports. A wrap back test can be executed 
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with this VI .  Both the serial ports must contain the similar basic configuration 

constraints.  The joining of  two ports utilizing a null modem cable efficiently joins 

one port's Receiver  lines to the other port's Transmitter  lines.  In  the block diagram 

it can be observed that  the VI calls the VISA Configure Serial Port VI for two times, 

one time for each of the two ports. This popups two individual VISA phases in which 

one of the VISA session executes the Write operation and the other executes the Read 

operation. As  two of the  VISA sessions are opened, the VI includes two individual 

VISA Close functions.  

 

 

Figure 3.22 - Block Diagram to check the instrument connectivity using VISA -2  

  Port serial write and read window 

 

3.5.3 Communication and Data Transmission/Reception 

Making use of the two programs conversed before it is likely to detect the instrument 

connected and only means ,either transmission or reception of data can be verified. 

Whereas the advanced serial read and write program executes a serial port read and 

write, or a blend of these two  actions while fixing some advanced serial features like 

buffer size, termination characters, and XON/XOFF flow control. The user chooses 

the functions (read or write) on the front panel.  If  both functions are chosen, the VI 

will write the data primarily, read the data and then abort the VISA session that is 

opened to the port.   
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The constraints fixed to the serial port must balance the constraints with  the  joined 

instrument. In this program, the bytes to read constraint state the no of bytes that the 

serial port reads. If there are more bytes at the port than the number stated in bytes to 

read, those bytes will not be read. Also, if you state, to read more bytes than the 

specified number of bytes, you might get a timeout error message.  

The steps included are: 

1. Choose the serial resource and configuration constraints (baud rate, data bits, 

parity, stop bits, flow control). 

2. End character can be enabled and fixed.  Also, fix the specified input buffer 

size before the program. 

3. Choose the functions to be carried out. Attach the serial port to your 

instrument.  If none of the devices is available, carry out a loopback test by 

doing one of the following. Connect pins 2 and 3 on a RS-232 cable or short 

pin 4 to pin 8 and pin 5 to pin 9 on a RS-485/422 cable. 

4. Execute the VI to see whether the data is read.  (The "read string" will balance 

the "string to write" if a test called loopback test  was executed). 

 

The present program displays many advanced features which are essential for the 

application proposed.  The input buffer magnitude is an vital feature that must be 

regulated  in the present application.  This program extends upon the flow control 

option for XON and XOFF, permitting the user to select those regulating characters.  

The timeout constraint has been brought to the front panel so that a user can state the 

time period the VISA Read will wait for the number of bytes to read prior to time out.   

 

Fixing the timeout period confirms that the operation gives a timeout error if the 

operation is not executed  in the stated time period.  Some instruments needs  a 

termination character so as  to recognize the end of command strings.  Some 

instruments passes a termination character to indicate the end of data to be read. This 

program displays how an individual can end the Read operation once a termination 

character is identified in the buffer and/or attach a termination character at the end of 

the Write data. To permit the Read to end on a termination character, utilize the VISA 

Configure Serial Port or  the VISA Properties Serial End Mode for Reads, 

Termination Character Enable, and Termination Character.  To abort the Write with a 



Experimental Hardware                                                                                 Chapter3 
 

77 
 

termination character, utilize the VISA Properties Serial End Mode for Writes, the 

Send End Enable, and Termination Character.  In this particular program, the similar 

termination character is utilized for both the Read and the Write.  The control and 

front panel of advanced serial write and read window is displayed in Figure 3.23 and 

block diagram in Figure 3.24. 

   

 

 

Figure 3.23- Connecter pane and front panel of advanced serial read and write  

window 
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Figure 3.24 - Block diagram advanced serial read and write window 

 

3.5.4 Using General Purpose Interface Bus-GPIB 

 

This program explains GPIB Read and GPIB Write. A device attached to a 

GPIB bus can be written to or be read from utilizing this VI. Input the GPIB Address 

of the device, select Read from Instrument, Write to Instrument, or Write then 

Read, type in the characters to be written, and execute the VI. If you select Write 

then Read, the VI will write to the instrument first, and then read from the 

instrument.  The Front panel dialog box  and block diagram for verifying the external 

device (Spectrum Analyzer) attached using GPIB is displayed in Figure 3.25 and 

Figure 3.26 

 

Figure 3.25 - Front panel window for checking the external device (Spectrum            

Analyzer) connected using GPIB  
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Figure 3.26 - Block diagram of window for checking the external device   Connected 

using GPIB 

 

3.5.5 Advanced Configuration using GPIB-VISA 

 This program needs NI-488.2 and NI-VISA to be loaded on the system.  The 

program demonstrates the procedure to communicate with a GPIB device using VISA 

reads, writes, and formatting functions on the received data.  This program will work 

using an NI Instrument Simulator or other device that has identical performance. The 

dialog box for advanced configuration using GPIB-VISA and its block diagram is 

displayed in Figure 3.27 and Figure 3.28.  

 

 

Figure 3.27 - Front panel window for checking the external device (Spectrum  

                     Analyser) connected using advanced configuration GPIB-VISA  
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Figure 3.28 - Block diagram instrument connectivity check using GPIB-VISA    

advanced configuration 

 

3.5.6  Advanced Peak Detector using Built-in Function in LabVIEW 

The ultimate aim is to save the maximum value of the Signal Strength vs. Time for 

every   10 seconds.  For this reason a program has been created to hold the maximum 

value of the signal during execution time. The program explains the utility of the Peak 

Detector. Utilizes Advanced Peak Detector Lab -VIEW program to find the locality, 

strength, and second derivative of peaks or valleys in the set of produce input data. 

Figure 3.29, 3.30, 3.31 and 3.32 demonstrates the dialog boxes for control and front 

panel for peak and advanced peak detection and display.  

 

Figure3.29- Connector pane and front panel of peak detection and display 
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Figure 3.30- Advanced peak detector connector pane and front panel 

 

 

 

 

 Figure 3.31- Block diagram peak detection and display. 
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Figure 3.32: Block diagram of Advanced Peak Detector connector pane and front  

panel (Built-in Function) 

 

3.5.7 FFT and Power Spectrum Functional Window 

Using this operational dialog box Power Spectrum of the real time data can be viewed 

directly during run time, as  it is a in built  function in LabVIEW, and may retard the 

action of data logging until the system furnished with is excellent RAM. The FFT 

power spectrum dialog box is displayed in Figure 3.33. 

 

 

 

                       Figure 3.33- FFT Power Spectrum Window 
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3.5.8 Data Logger with Events 

This window for VI Logger events in Lab-VIEW is shown in Figure 3.34. 

 

 

          Figure 3.34 - Data logging window sub window 

 

The block diagram of the data logging task is shown in Figure 3.35. 

 

                 Figure 3.35- Block diagram of the Data Logging Task. 
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3.5.9 Automatic Data Read Start and Stop Times for all Runs in a Task 

When recordings are to be done for lengthy periods, atomization is vital constraint, in 

this point of view, the choice of automatic data read initial and final  time options 

offered in Lab-VIEW for executing all the jobs and respective windows are shown in 

Figure 3.36. Returns a table of initial and final, times and dates for the execution in 

the logging task  identified by Task Name for next viewing sessions. 

 

       Figure 3.36 - Schematic window shows recorded data files. 

 

Initial and final Times shows a table of the initial and final  times and dates of the 

execution of the designated VI Logger task. This table may take some time to occur, 

based on the pace of your computer and the number of runs being regained. Event 

Name (abc) Event Name is the name of the logging task you want to see  run times 

from. Leave empty to popup  a dialog box window from which task name can be 

selected. Event Name Selected (abc) Event Name is name of the event from which the 

table of initial and final times and dates are being viewed.  

 

The block diagram to describe the data files saved in the system in course of real time 

experimental set-up is shown in Figure 3.37. 
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Figure 3.37: Block Diagram to view the data files stored in the system during   real 

time experimental setup 

 

The block diagram explains how to save time-domain and frequency-domain data to a 

TDMS/Excel file using the Write to Measurement File Express VI, which is an 

important task for retaining the data and is shown in Figure 3.38 

 

Figure 3.38- Block diagram of writing real time data received into Excel or  

LabVIEW compatible file for post processing/analysis.  
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The complete task of device connectivity to data logging event and the 

hierarchy is displayed in Figure 3.39 and 3.40 which fulfills the experimental set-up. 

 

 

 

 

 

Figure 3.39-Shows hierarchy of Data Logging Task in detail 
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Figure 3.40-Shows hierarchy of instrument connectivity to data writing to an excel 

file 
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3.6 SUMMARY AND CONCLUSIONS 

 

Satellite-TV downlink receiving station using DTH was installed for the 

purpose to study the propagation impairments. The main purpose of this work is to 

investigate the attenuation effects due precipitation on direct broadcasting TV signals 

which are in the Ku band frequencies coming from geo-stationary satellites by using 

the antenna, experimental set-up , data logging modules developed. Using the data 

obtained from measurements post processing analysis to be done and based on the 

best results prediction model for rain attenuation studies is developed.  

 

Using the potential features of Lab VIEW data logging task for the studies 

related to Propagation Impairments of Ku and Ka-band Earth-Satellite paths is 

achieved. The detailed steps of developing the data logging system is provided which 

will be helpful for propagation engineers to establish similar set-up for the application 

studies. For successful experimental set-up, it is obvious to have all the device drivers 

corresponding to the hardware used usually will be provided by the manufacturer. The 

module developed once configured properly, it will automatically start the task of data 

logging for the sampling time usually chosen by the end user.   

The developments related to hardware and new releases in software leading to 

more benefits like very accurate data logging. Since the proposed signal usually a 

down converted signal of Ku-band and is transmitted from satellite proper power 

levels as per the spectrum analyser specifications to be chosen otherwise hardware 

may damage. It is always better to choose auto configuration option available in 

hardware during fetching the signal from DTH.  

 

The final outcome of the experimental set-up using the DTH system and 

spectral analyzer is Signal Strength (dBm) with reference to the time. Along with the 

rain rate data collected from disdrometer more number of studies can be made 

pertaining to propagation impairments. 
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